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Benvenuti in TopSolid

Benvenuti in TopSolid 2024

Questo documento presenta i principali miglioramenti ed evoluzioni introdotti nella versione 6.25 del software
TopSolid v6. Le innovazioni qui descritte sono solo una parte delle nuove funzionalita innovative incorporate nel

software.

Per scoprire le altre novita, contattate I'agenzia piu vicina a voi.
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Cosa c'e di nuovo in TopSolid'Wood

Novita di TopSolid'Wood 6.25

Questo capitolo descrive le novita della versione 6.25 di TopSolid'Wood.

Interfaccia utente

Comando a parete in modalita neutra

E ora possibile utilizzare il comando Modalita neutra nell'area grafica per creare pareti.

o|p10|&l8| 88l ul = = =[5

E ora possibile utilizzare il comando Modalita neutra su un muro per gestirne la visualizzazione.

Hﬂ @ characTerisTics| B sketcH| P measure| 4 |1 & @] | 0| [F] |

Wallz visualizatinn=| Marmal

Oriented
Cut
Oriented and cut

Definizione di piu parti dall'albero di costruzione

I comando di definizione di parti multiple € ora disponibile nel menu contestuale dell'albero di costruzione.

L'assieme principale e il primo nodo dell'albero forniscono il comando Caratteristiche multiple che visualizza le
linee selezionate nella finestra di definizione di parti multiple.

- @EH
- (0 o
- (0
=g (0

_‘c)
1
&
&

-

77
L]

3% ASSEMBLY: (2)

=] @ G1: Group 1 (3)
{ - (0) @47 : a
:;v" (0)@76: b
. F-"§ (0) @62 :d

Analyze

Delete

Extract

Insert

Name
Controls
Visible = YES
Characteristics

Multiple characteristics
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Modifica della modalita BOM

Cosa c'e di nuovo in TopSolid'Wood

E ora possibile definire la modalita di distinta base di una singola unita o di un sottoinsieme di un
componente direttamente dall'assieme finale. Nelle versioni precedenti, questa funzione era possibile solo sul

primo nodo dell'albero.

=8 ASSEMBLY : [MIXED] (3)

B@ G1_001 : | [Serialized) [MEXED] [3)

-] (50) @47138 : Sub Slope Box [MIXED)
i (50) @47308 : Sub Slope Box [MIXED]

EICI 249769
&0 @49161 - o Analyze

=01 @49197 - 2 Delete

3]
638 Advanced

Manage commands
Define sub-component

Update components drivers

Mare commands >
{8 G2: Group 2 (0] - ]
o@D G1_002: . (Ser o Edit
#-C1] [50] @4738; Edit sets >
- (50) @4751: Edit boms 5 |

Bill of material = SUB-ASSEMELY

Filtraggio hardware

| comandi per I'assemblaggio di spine, eccentrici, viti, lamelli, componenti estrusi e kit di assemblaggio ora

visualizzano solo la ferramenta compatibile.

"X X

E possibile utilizzare questo meccanismo di filtraggio dei componenti standard per creare le proprie librerie.

Standard companent inclusion X Standard component inclusion
Fiber Sesndud B Fites Shardand
- TopSokdWoed
Wood
o@% t
Standard component inchsion x Standard component mchiasn
Fiter Standandt Fites Standend
TepS ok woed TopSokdWoad
Farmdy type voriank ' Fardy fype, variari: ]
2 Togfokfwiood A wd 10 0 TeeSobwiond i
£ ety C3 vty
20 Dowels ¥ 3 (2 Mot serom
) Wood dowel 08 {2 Wood seiew
) Corfrraat hewagon sncket scoeey
L3 ] Cruciom wood scoew L 75
] Ewoserem

x Standard companent inclusion 4

Fiter Stareiand

£ Standard comporeen inchition ®

Fibes Standied
TopSokdwiood
Fairdy hype. veriarnt
3 TeeSckdwiond
3 vty
£ Cane
] Corm cone
] Com dowed
] Simple cam

Aggiungete la riga di comando corrispondente al file lib.cfg nella radice della vostra libreria standard:

Spine:
D_COMPO_ZWOO_PIN "Famiglia" "Tipo" "Variante"

Kit di montaggio:

D _COMPO ZWOO_KIT "Famiglia" "Tipo" "Variante"

Lamelli:

D_COMPO_ZWOO_LENS "Famiglia" "Tipo" "Variante"
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Cosa c'é di nuovo in TopSolid'Wood

Eccentrico:

D_COMPO_ZWOO_ECCENTRIC "Famiglia" "Tipo" "Variante"
Vite:

D_COMPO_ ZWOO_SCREW "Famiglia" "Tipo" "Variante"

Componente estruso

D_COMPO ZWOO_ EXTRUDEDCOMPONENT "Famiglia" "Tipo" "Variante"

Filtrazione degli utensili di lavorazione

| comandi per la lavorazione di scanalature, battute e profilature visualizzano solo gli utensili compatibili. E possibile
utilizzare questo meccanismo di filtraggio dei componenti standard per le proprie librerie.

Aggiungere la riga di comando corrispondente al file lib.cfg nella radice della libreria standard:
D_SH OP_ZWOO_SHAPING FILTER SLOT "Famiglia" "Tipo" "Variante"
D SH OP ZWOO SHAPING FILTER FOLD "Famiglia" "Tipo" "Variante"

D SH OP ZWOO SHAPING FILTER MOULDING "Famiglia" "Tipo" "Variante"

4 TopSolid



Dattilografia della parte

La scheda Visualizzazione dell'albero di costruzione presenta due nuove scorciatoie per la digitazione dei pezzi. E

possibile:

Cosa c'e di nuovo in TopSolid'Wood

= o utilizzare la rotella per impostare il valore corrente predefinito;
< oppure trascinare e rilasciare nell'area grafica per la selezione manuale.

. @] Hardwood
/ [@] laminate shape

\ "\ &

Ricerca per completamento

La nuova opzione combinata Ricerca sensibile alle maiuscole nella finestra di dialogo, disponibile in Strumenti

S

Detached trees o B
Visualization

Y FILTERING OPTIONS
5. ¥ User types
@] Equipment
=] Front
@] Glass
[a] ground
@] Hardware i l

@] Laminates
a] Lights

a] Piping

a] Profile

al wal

-

Status bar configuration O x |
+ Screen
+ Miscellaneous
-/ Altributes
Font
Transparency
Current layer:
Current line style
# Cument material H1115-S
Type Hardwood

> Opzioni > Diversi, garantisce una sintassi esatta durante la ricerca per completamento.

TopSolid

----- = [
[+ Shape

----- = Material filtering

Ej--]:‘ Interfaces

6= Nesting

----- L Compaszs/onented cube

----- i® Start page

j--& Sheet metal : design

H-5 Sheet metal - unbending

H- Sheet metal : converting

JE Sheet metal : bending wizard
j"ﬂ‘. TopSohid'Planner configuration

e OO s OO o O T |

Scale |

Tent ]

B Use modification parameter dialog box

Tranzparency =5 |

[ Dizplay long name of materials

B Caze sensitive search in dislog box combo

Fast definiton x
Mumbrenrg Felp
Diesgnation »|8
Hack
Fietererce 3 Bacipsch
Supicies 3| Base Eotlom
Baze Side Leht
Procesing *| Base Side Right
Base Top
Pat catopuy *| Beam
Bolfiom
Bl of matenal Hox
Cosbing Heachel

Custingup Bulrose

Part definiticn X
Humbseting helps

Diegriation :lh

Flabesencs 3

Srgeder

Procusting 3

Fast calegony



Cosa c'é di nuovo in TopSolid'Wood

Includere un componente standard dall'albero

Gestione dei parametri

Quando si include un componente standard dalla struttura, la finestra di dialogo di configurazione del
componente non viene piu visualizzata quando non é disponibile alcun parametro.

Standard components

D Filker Standard: Companent configuration %
Parameters
TopSolidWwond v Designaion Vae U /
Search | A %]
(B © Only variant

TopSolid"ood

[ Acceszones

[— Decoration Code /
Badge entr Key point ;
q ¥
Apply changes |T
. Flat Bntl_',' Infarmation:
B . Lozange entry L3 Cancel »

Modalita avanzata

La modalita 22 estende il pannello laterale della finestra di configurazione del componente per
impostazione predefinita quando il componente ha parametri opzionali o secondari.

Nel caso in cui il componente ne sia sprowvisto, il pannello laterale crolla.

La modalita « visualizza la finestra di configurazione in modalita minimalista e i parametri avanzati non
vengono mostrati.

Component configuration *
Parameters Optional Secondary
Deszignation Walue L.
Designation Walue u Share
angle "5 - 5" 1] * Mone
overlenght bottom groove 1] mnm
overlength top groove 1] mm

Code

TYPE M1-F1 ~
Key point
Drilling o part 1, Male > Apply changes %: ’T‘
Informations
| [TrPE MIFI
ak. Cancel >3
Nota: nel iA quando un componente non ha un parametro principale ma ha un altro parametro

il pannello laterale & ancora espanso.
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Ricerca dei componenti

Quando si cerca un componente, I'albero dei risultati della ricerca viene espanso automaticamente.

Main  Favorte Mainset Ertiies Layers Standard components
(I Filter Standard
TopSaolid'wood v

Search.|sclew A %
oAl () Only variant

TopSolid/ood

=] Accessories

Suppott

‘ hetal rack to screw
= Aszembly
B Hides
‘ Screw mask
= Metal screw
‘ Flat head screw

‘ Head cracked screw

‘ hetal screw
‘ Threated rod

=] Wwood screw

‘ Confirmat hexagon socket screw

‘ Cruciform wood screw

La ricerca del testo in ingresso viene effettuata sulla struttura standard dei componenti (Famiglia/Tipo) o solo sulla
variante, come nelle versioni precedenti.

Search: [screw | K
[« F] () Orly wariant

Libreria standard: personalizzazione dell'immagine del tipo di
componente E possibile personalizzare I''mmagine di anteprima del

tipo di componente standard. Deve soddisfare i seguenti criteri:
= Il suo nome deve essere "nometipofamiglia.png".

= Le sue dimensioni devono essere di 40x40 pixel.
= La sua posizione deve essere alla radice del componente standard.

- )

TopSolid



Cosa c'é di nuovo in TopSolid'Wood

Designazione di parametri predefiniti

La finestra di dialogo di configurazione dei componenti standard ora visualizza le denominazioni dei parametri predefiniti

Component configuration X 1‘
|

_Paametees

Designation

Irtemnal cabmel width

Side color

Type biont foarg beacket
Type hont feeng beackel, top
Activate roeedswer

|{2INSERTA

{3Screwon

Type front fixing bracket 1:EXPANDO T
Type front fixing bracket, top 1-EXPANDOD T

Activate innerdrawer 2INSERTA
3:Screw-on

L

TIPON?

Code
300

Key pont

Pottioerement & teor - Sur le cité drot du caisson - Baz

Apply changes

[

o | Cancel »

Modifica degli elementi
I nuovo comando Modifica > Modifica elemento consente di cercare un elemento e di visualizzarlo nell'albero.

Edit

xl.ll..ll.ll..ll.ll
,}J Delete

"»| Edit element

E possibile configurare una scorciatoia da tastiera per il comando in Strumenti > Opzioni.
Shortcut key
Family :

Edit ~

Commands :

Delete
Edit element
hd ~ Ak

TopSolid
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Eco di selezione nei configuratori

E ora possibile gestire I'eco dei pezzi nei configuratori del legno (Materiale, Proprieta, Esportazione, Nesting,
Lavorazione e Redazione).

L'impostazione dell'eco per gli elementi della struttura definita in Strumenti > Opzioni > Altro viene applicata a questi
comandi del legno.

Elements echo from tree
) Precise

() Fast partial
O Noecho

Semi-assemblaggio sul posto

Denominazione

[l menu contestuale di un semi-assemblaggio sul posto include ora un comando di denominazione.

B ASSEMELY 12
@ component
() AT AT(0)

o Analyze

z Delete

# Extract DKl Serial set= NO ¥4 Mame: Designation:
# Insert

= Controls
®  Characteristics

% ASSEMELY : (1)
-8l A1 : A1 (1)

Denominazioni dei semi-assemblaggio sul posto nei configuratori

Le funzioni di configurazione di TopSolid Wood visualizzano ora le denominazioni dei semi-assemblaggio sul posto
nei menu a tendina di selezione dei sottoassiemi.

MAIN ASSEMBLY | Sub-assembly= 1 fin place subrsel)/Group 1 | Depthy MULTILEVEL - |

TopSolid 9
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Volumi di costruzione
La scheda Entita presenta una nuova sezione per l'organizzazione dei volumi di costruzione.

Entities

3% ENTITIES SET: (5)
.4} PARAMETERS : (0)

=-{JiSET OF CONSTRUCTION VOLUMES : (3%
- “# (99) Construction Yolume 1
+-*§ (99) Construction Yolume 2
#-*f (99) Construction Volume 3

o-*f SHAPES : (3)

[ CURVES: (3)

-}« CODRD SYSTEMS : (1)

F-

&

Set di pannelli

Un nuovo set denominato SET_PANELS visualizza tutti i pannelli del documento. Sono disponibili diversi filtri per una
visualizzazione piu precisa:

= Pannelli in opera: pannelli progettati nel documento.
= Pannelli di componenti: pannelli di componenti.
= Tutti i pannelli: i due tipi di pannelli precedenti.

O

Analyze

(0) panel pi
(0) panel pi Visible = YES

[

Characteristics

All the panels

In place panels
Component panels

Simplified panels

OO00O0OR &

Detailled panels

[ filtri Pannelli semplificati e Pannelli dettagliati verificano le rappresentazioni dei pannelli.

1C TopSolid
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Design
Kit di montaggio

Kit su parti non perpendicolari

AT
/ k““*-._\
~—

e T~

Una volta attivato, il nuovo comando di gestione degli angoli crea un parametro angolare nella sezione del kit
di montaggio. E disponibile solo quando sono attivate le modalita di gestione delle facce non parallele e di
gestione dell'inversione.

ER dsfinition - ADVAMCED ASSEM
T ——— Analyze
- ¥ Main part o £
- ¥ Opposite part _"':J Delete
""" &2 L: Length parameter = 500mm More commands > Manage commands
----- £ th: Centering thickness parameter = 30
= . Mon- llel t = YES
----- £ tw: Thickness parameter of the part in ¢ on-paraliel faces managemen
..... E2 Inw : Inversion parameter = Yes Inversion management = YES
----- £ angle : Angle parameter = 907 Angle management = YES

| kit di montaggio delle versioni precedenti possono essere aggiornati allo stesso modo.

Quando il kit € incluso, ogni gruppo esegue la propria misura angolare e fornisce il risultato al kit, aprendo cosi
nuove possibilita di gestione dei collegamenti angolari.

L'angolo misurato & il risultato di due piani/direzioni.

Il sistema di coordinate di posizionamento del kit fornisce il primo piano della misura e la direzione Y+ del sistema di
coordinate di posizionamento (vedere la freccia viola nell'immagine sottostante) fornisce la prima direzione.

Sulla seconda parte da assemblare rispetto a questa direzione Y+, si identifica il secondo piano/direzione. L'angolo
corrisponde a questi due piani nelle direzioni delle frecce viola e gialle.

TopSolid 11
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-~ @
i
N
\"""“--._ =
. > ~».‘__\\
iy

=
K
S
¥ = .
e

Pyt |

"

Definizione opposta nell'assemblaggio automatico

L'assemblaggio automatico puo ora scegliere tra la definizione principale e quella opposta.

Inversione di definizione
Quando si utilizza il comando Assemblaggio automatico, una nuova sfera blu da accesso alla

modifica del kit. Una nuova icona "frecce blu" consente di selezionare la definizione opposta del kit.

Kit DG v| 8| & ul

/| 4
Ko g -Coms o) % X ¥asrgin-Cam o & ¥

Il kit é posizionato nella direzione opposta.

Memorizzazione dell'ultimo kit utilizzato

In Strumenti > Opzioni > Configurazione TopSolid Wood > File > Assemblaggi, & ora possibile definire il kit di
assiemi cheverra utilizzato di default in ogni nuovo documento.

Cateqories

-- Tools

EI Assemblies
- Drefault dowel

- Drefault cam

- Drefault sorew

- Drefault len or domino

- Default extruded component

Jefault azzembly kit $5TD=TOPWOOC

----- Default edge

zzemblyhadvanced kitzHy = z and CamzsHl=01#R=MR.top

Inoltre, TopSolid memorizza I'ultimo kit di montaggio utilizzato, consentendo di utilizzare pit comandi di montaggio
in successione senza dover selezionare ogni volta un kit. Il valore predefinito viene ripristinato al successivo avvio di
TopSolid.

12 TopSolid
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Esportazione multipla di geometrie

Basato sullo stesso principio dell'esportazione multipla delle lavorazioni, il nuovo Legno > Esportazione geometrie
consente di esportare piu volte le geometrie dei pezzi in formato DXF o PDF.

Wood

2 srrarssnnsnarsstssnasarsnnannas

£9) Text outline

@ Machining export 5 Export format=| Autocad
% Cut export » ¢

= Export bill of material

‘B9 Export geometries

% TopSolid'WoodCam ’

& TopSolid'Wood Help

Nota: in Strumenti > Opzioni > Configurazione TopSolid Wood > File > Associazioni distinte basi, € possibile
definire un modello di distinta base per controllare il nome dei file generati.
Ricerca nelle operazioni di lavorazione del legno

La ricerca & ora applicabile alle operazioni di lavorazione del legno (scanalatura, battuta e profilatura).

| Parameters
Standard:
TopSalidood A4
Search:l A %
Al © Only variant

Lavorazione dell'utente a faccia inclinata

Quando si crea una lavorazione utente di una faccia inclinata, la nuova opzione Automatico rileva
automaticamente le facce laterali adiacenti alla faccia di riferimento selezionata.

Per ogni faccia selezionata viene creata un'operazione.

3% ASSEMBLY: (2)

=@ (0) Auto Slope

[=-*§ (0) Slope Face
_) (R
+-% (0) sloped face = *
+-% (0) sloped face = *
+-% (0) sloped face = 0
+- 4P (0) sloped face = 0
+- 4 (0) sloped face = 0
+-4 (0) sloped face = 0
+-4 (0) sloped face = 0
ﬂ,ﬂ [0) extruded shape on curves
-4 Tool number

TopSolid 13
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Blocco driver

Alloggiamento manuale

L'inclusione di un componente del blocco driver nella modalita In alloggio offre una nuova opzione (Manual) per
controllare manualmente i sei piani che definiscono la posizione/dimensioni del componente.

Housing mode=| HOLSING v | ManuaL |

| primi due piani definiscono la parte anteriore e posteriore del blocco driver. | piani successivi sono liberi e
definiscono a coppie la larghezza e I'altezza del blocco driver.

Blocco driver e codice catalogo
Le nozioni di blocco driver e di codice catalogo possono ora essere combinate.

Quando un codice di catalogo compila i parametri per un blocco driver (ad esempio, blocco.x, blocco.y e
blocco.z), il processo di inclusione non richiede piu questi parametri e il catalogo ha la precedenza.

at: - tor
Catalog edito

Code  Matter Coating Finishing  Alias

Code block. = [mm) block.y [mm] block.z [mm] hip [
500 500 500 700 100
E00 E0O 500 700 125
700 700 500 700 150

Double click to add a code

t Columns management X

[:_] Column
[t ain zet

La modifica del codice del catalogo ridimensiona i valori del blocco del driver.
Nei casi in cui il driver viene forzato, esso prende il controllo del catalogo.

14 TopSolid



Ricerca di componenti standard
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La ricerca avanzata, sull'intera struttura o solo sulla variante, & disponibile anche quando si include un
componente tramite il comando Includi standard.

Standard component inclusion

[CJFilter Standard:
WY 3D STANDARD

Fanily type, variant;

tl Clamesx Mew Generation
=2 what's New 2024

G- Assembly Kits

- Bloc Driver - Box
G- Bloc Driver - Doors
- Bloc Driver - Fumiture
G- Bloc Driver - Shelves
-] Distribution

{:I Doors

- Hardware

- Include STD From Tree
- Labels

- Misc

- Profiles

@] Shiding Door

Wergian:

Reprezentation:

Code:

*
Auxiliary elemerts  Properties  Attibutes  Search
Search
- Search:l A %]
TopSolid  :.:
(") Flat
Wood ) O Multi-level
Type of zearch
ou _
)] () Orly wariant
%ﬁq
Paramsters:
Conco «

Distribuzione vincolata dei blocchi

E possibile ripetere un blocco vincolato utilizzando il nuovo comando contestuale Ripeti.

= *§ (0) constrained block
J= (0)ABSOLUTE COORDINATE SYSTEM
€3 Thickness = 1%wm

(0) Fust plane

First shift = Ooom

(0) Second plane
Second shilt = Oeeen

(0) Fst plane

Fast shit « Omm

(0) Second plane
Second shift = 25men
(0) Positioning plane
Pozitioning sht = 100mm

TopSolid

8 1(0) constrained block © Analyze

2} Delete
Modify
Controls

@

=L A W )

Activate all

-
o

Serial copy
Repeat

||

Designation

Activate only layer = 0

layers

15



Cosa c'e di nuovo in TopSolid'Wood

Sono disponibili due modalita:

- Distribuisci: la faccia iniziale, la faccia finale e la quantita sono specificate come per una distribuzione
quando si crea il blocco vincolato.

- Lineare vincolato: si specificano le facce iniziali e finali, quindi si apre la finestra di definizione della
distribuzione come per la creazione del blocco vincolato.

Nel caso in cui il blocco vincolato da ripetere abbia kit e bordi, la ripetizione si applica anche a questi ultimi.

Modifiche multiple del driver

Quando si modificano i parametri di un componente, i nuovi pulsanti Modifica tutto e Unisci tutto possono
essere usati per modificare o unire i parametri selezionati.

Parameters list of a component : @136

Selected parameters
Table Enport Export and print Modify al Merge sl

Mir # b ax Fredefined values  Copy predefined values  Faste predefined values

Memorizzazione dei punti chiave quando si includono piu componenti

Quando si inserisce un componente contenente piu punti chiave, la selezione di un punto chiave diverso dal
primo dell'elenco viene salvata se viene posizionato un secondo componente.

Una volta convalidato il primo componente, € possibile posizionare un secondo componente con l'ultimo punto chiave
utilizzato.

Key point=| DRILLING ON PART 2, MALE F

DRILLING ON PART 1, MALE
DRILLING ON PART 2, MALE
DRILLING OM P&RT 1, FEMELLE
DRILLING ON PART 2, FEMELLE

Configurazione predefinita standard dei componenti

Ogni libreria standard pud ora definire il tipo di componente predefinito utilizzando una parola di
configurazione. Per ogni libreria, aggiungere la riga p_covpo_rirst che indica il tipo predefinito:

D COMPO FIRST "Standard" "Famiglia" "Tipo"
| nomi di standard/famiglia/tipo devono essere inseriti esattamente come appaiono nell'interfaccia di TopSolid

(a differenza del nome del file sul disco). Si raccomanda di prestare attenzione alle maiuscole aggiunte da
TopSolid e di utilizzare le virgolette quando il nome contiene spazi.

1€ TopSolid
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Dichiarazione di un sottocomponente

La dichiarazione di un sottocomponente inizializza il codice, la variante e la cancellazione per impostazione predefinita.

Sottogruppo seriale

Il nuovo comando Serializza sottoassieme serializza un sottoassieme tramite una ripetizione, una distribuzione o un
gruppo.

Analyze

Delete

Extract

Insert

Marne

Controls

Characteristics

Multiple characteristics
Edit properties

Bill of material = SUB-ASSEMBLY
Representation = MIXED
Serial = NO

fEw- @80 Foee@

@

Add new inplace subset
Serialize sub-assembly

More commands >

[l numero di sottogruppi creati dipende dal numero di parti ripetute o distribuite o dal numero di elementi del

E B/ E_

Sl SHAPES - [1]
LB 4k @45 ﬁ ASSEMEBLY : (4
_@ Fresults (4] +@ A1_001 ;| (Senialized) [0
i L. § Instance 1 - 41_002 :, (Sendlized) (0]
“§ Instance 2 +@ A1_003 ;| (Senalized) [0
“§ Instance 3 +@ A1_004 ;| [Senialized] [0

TopSolid 17
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Sottogruppo seriale e copia seriale dei componenti

Quando si include un componente, in base alle impostazioni definite in Strumenti > Opzioni > Componenti >
Gestione componenti > Scelta intersezione, ¢ possibile definire il sottoassieme in cui il componente deve essere
creato.

DKl Inzert in=|G1_DD1 Group 1 [in place sub-zet] |v
rAAIN ASSEMBLY

G1_001 Graup 1 [in plac

Nella situazione in cui il sotto-asseblaggio sul posto € serializzato, una copia seriale automatica di questo
componente avviene all'interno di ogni sotto-assemblaggio sul posto.

[MIXED)] [3]
E@ G1_001 : , (Serialized] [MIXED] (1)

3% ASSEMBLY : [MIXED] (3] ¢ -1 (50) @47308 : Sub Slope Box [MIXED)
=8 G1_001 - , [Serialized) (MIXED) [1) . 53 Advanced
--CI [50] @49178 : Sub Slope Box [MIXED] é--@ G1_002 : , [Serialized) [MIXED]) (1)
- 62 Advanced ¢ -1 (500 @47519 : Sub Slope Box [MIXED)
@ GE1_002 : | [Seralized) [0] {5 Advanced
(@) G1_003 ., [Serislized) (0] =-{E) G1_003 : . [Serialized] (MIXED) (1)
-] (50) @47685 : Sub Slope Box [MIXED)
-8 Advanced

In questo caso, il componente dell'armadio & stato copiato e distribuito ai sottogruppi corretti in

posizione. In ogni armadio verra incluso un componente di scaffalatura.

#EASSEMBL\’: [MI=ED] [5):

EI@ G1_001 : . [Sernialized] [MIXED] (2]

-1 [(50) @49621 : Sub Slope Box [MIXED]
{:I [50) @49983 : Distributed Shelves
[-63 Advanced

E—ZI--@ G1_002 : . [Senalized] [MIXED] (2]

-1 [(50) @49695 : Sub Slope Box [MIXED]
{:I [50) @50064 : Distributed Shelves
63 Advanced

E—j@ G1_003 : | [Serialized] [MIXED] (2]

-] (50) @49761 : Sub Slope Box [MIXED]
Cl [50]) @50126 : Distributed Shelves

Il componente dello scaffale viene posizionato e le sue sei pubblicazioni si collegano alle sei pubblicazioni del mobile.

In questo caso specifico, TopSolid sara in grado di serializzare la copia di questo componente e di
copiare/distribuire gli altri componenti in ogni sottoassieme in posizione.

18 TopSolid
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Copia seriale cartesiana

Prendiamo I'esempio di un componente distribuibile verticalmente (a sinistra in basso). Questo componente € incluso e
distribuito verticalmente in modalita alternativa (a destra in basso). La distribuzione e definita come driver.

Dichiariamo una distribuzione orizzontale di questo blocco di volumi verticali (in basso a destra).

In un nuovo documento, inseriamo questa unita verticale e la distribuiamo

orizzontalmente. La modifica di alcuni elementi genera il seguente esempio.

WV

1
Ry
/

// \

)
N
=T

N _ T PN |
\ : /\ ___.// \/ /\ (‘; )
7 AN i /

Il blocco driver & incluso in una delle caselle, quindi viene lanciata la copia seriale.

TopSolid
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A seconda del volume selezionato, i componenti vengono distribuiti nei volumi corrispondenti.

In questo scenario, la nuova opzione Prodotto cartesiano propone il prodotto cartesiano della

copia seriale.

ﬁl Cartesian product= YES ¢:|

Copia seriale del blocco vincolato

Quando si crea un blocco vincolato automaticamente o tramite estrusione di facce su una delle facce di un
volume distribuito o ripetuto, & ora possibile serializzare |'operazione di blocco vincolato.

Dopo aver fatto clic sul pulsante Copia seriale, € possibile definire il posizionamento desiderato per il blocco vincolato
copiato.

AUTUMATICI Serial mode= NORMAL | First plane: AUTCIMATICl Serial mode=| NORMAL ~ | Second plane:l AUTOMATIC| Serial mode=| NORMAL | Pasitioning plane: |
2C TopSolid
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Nuova libreria Blum Merivobox nel TopSolid'Store

La nuova libreria Blum Merivobox & disponibile su TopSolid'Store.

220 LM _Library
[ % Drawers unitz
= - BLUM MERIMNOBOX Component configuration X
Parameters
% Designation Value u Share
S - E 40kg Intemal cabinet width &00 mm
= Side color 1:5WM Mone
Type of side 106 alleny Mone
% Tise front fixing bracket 1 EXPAy Mane
el i | E 70kg Type front fising braguet, top 1.EMPE Mane
Innerdraver 7 ONo Mone
ui;ut E 70kg - For waste bin application
I( 1 TIPON 7
e iy K dlkg
K, e
e By K Tkg - -
m Ky paint
e o) M 40kg Dravier posiioring - On fight cabinet side - Eoltom v oy chenges & [,
I}%‘_‘I M 7Okg |
' l oK Cancel >
e pog N 40kg
[ ‘}' MERMNDEDX Components

Nuova libreria di fissaggi intelligenti IF in TopSolid'Store

La nuova libreria di fissaggi intelligenti IF & disponibile sul TopSolid'Store.

TopSolid

Standard component inclusion

() Fier Standaid:
IF Indeligert Fidngs
Famiy lyne, vaiianr

o g make
I stronger
connections

% IF Inteligent Fiings
Search| A ¥
if IF Inteligert Fidngs
Peanut
Pl
P2
P P2
‘ Peanut 2 Shodt
P3
L
- Pesrai 3Long
Tacing
Pasnut
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Misure di distanza

Nel comando Analizza > Distanza, lo stato del pulsante Elimina misure predefinite viene ora salvato per la
sessione.

Analyze

x'...........
¥ Element ouIT] PLANE | 4415 | SHAPES | Delete previous measures= YES €2
= Angle

T——

Etichette di valore

Nelle versioni precedenti, quando si modificava il valore numerico di un parametro, TopSolid visualizzava
un'etichetta nell'area grafica, permettendo di modificare il valore tramite un campo o un cursore. Sono stati
apportati diversi miglioramenti.

Gestione dei valori min/max

[ valori minimi e massimi di un parametro vengono ora presi in considerazione.

3 ENTITIES SET: [5)

-l SHAPES : (1)

L. COORD SYSTEMS : [2)
CURVES : [2)

b PARAMETERS : (3)

~E23 A1+ A1 = 250mm [100,350]
623 A2 A2 = 457 [35,55]

A1=250mm VB Moo o &
v

Gestione della trasparenza
E ora possibile definire il valore predefinito per la trasparenza delle etichette nel file top.cfg:
D_DOC_PARAM EDIT INPLACE TRANSPARENCY 0

Il numero dopo la parola di configurazione determina la trasparenza dell'etichetta (0 = nessuna trasparenza).

A1=280rmm = |1.00 b4
100, 350,

Trasparenza: 5 Trasparenza: 10

Maniglie (parametri, componenti e driver)

Sono stati apportati miglioramenti per migliorare alcuni concetti, come i parametri, i componenti e i driver, utilizzando le
maniglie-parametri. In questo modo & piu facile modificare i parametri quando si modificano i driver del componente
incluso.

La creazione di una maniglia-parametri genera un insieme di tabelle per la gestione delle evoluzioni successive.

22 TopSolid
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Parametri

E ora possibile creare una maniglia-parametri tramite il menu contestuale, facendo clic con il tasto destro del mouse su
un parametro e selezionando l'opzione Aggiungere maniglia guida (add driving handle).

oK Type-

DIMENSION

OFFSET
ALUE

[ A1 [A1=250mm

CRIVER HAMDLES : [4)
STEP: [Step=0]
s Etape_1 (3)
EI.EI Foignée_AT : component modification handle [Step=1]
E:i Parameter [Dimenszion)
----- £ A1 : Parameter = 250mm [100,350]
- % First reference point = -92.5,227 5,250
- Second reference point = -92.5,227 5,250
E—ZI.EI Foignée_a2 : component modification handle [Step=1]
E:i Parameter [value)
----- £ AZ: Parameter = 45° [35,55]
- % Heference point = 137.5,227.5,250
BF' Foignée_&3 : component modification handle [Step=1]
E:i Parameter [Eoolean)
----- £ AZ: Parameter = No
[+ % HReference point = -92.5,-355_250

e

Nel creare una maniglia-parametri, & necessario darle un nome e inserire un numero e una descrizione per il passo.

ok Name=|F":'iEl""éE_-‘f'\"'I !3te|:=|'I Step name= Etape_1

Per modificare la maniglia, fare clic con il pulsante destro del mouse sulla riga della maniglia nel set di maniglie e

selezionare il comando Modifica.
|

2] Delete
& Modify

Aggiornamento

Una nuova icona di blocco consente di ritardare il calcolo dell'insieme di valori per una maniglia-parametri.

Se si desidera esporre un gran numero di maniglie, puo essere opportuno organizzarle per gradi.

Gestione delle fasi

TopSolid 23
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g

Mode Oﬂacllx

Construction Yolume Wldlh| EI]l]mm|
Construction Volume Helghll Bl]Dmm|
Volume Depth F-‘nshinn|D:Ba:k|
Yertical nﬂset[ Omm |

3 hollsl kel E

¥ DRIVER HANDLES : ()
o J3 STEP: (Steps0)
= 2 Step_1(5)
Handie_pastion : comporert modécation hande [Step=1)
‘ Handie_w : componert modiication handle {Stop=1)

S
0 Handie_h - companent modification handle (Step=1) P T
: Handie_d_z : componert modéication hande [Step=1) ' s
i Handie_mode : comporent modification hande [Step=1)

o

N

Esempio di maniglie raggruppate nello stesso passo.

3 DRIVER HANDLES : [8)
#-J STEP : [Step=0)
-1~ & Main Parameters (3)
# Handle_w : component modification handle [Step=1] i
[ E Handle_h - companent modification handle [Step=1] N
* F Handle_d_z : companent modification handle [Step=1] R
-~ & Advanced Parameters (2)
(s J3 Handle_position : companent modification handle [Step=2)
& F Handle_mode : component modification handle [(Step=2)

[P Aavanced P
) {epde O X
< vl -

Esempio di maniglie organizzate in due fasi.

Componenti
Un componente standard definito come sottocomponente viene utilizzato per creare una maniglia del componente.

Sub-component definition x

il Bill of material

8 = | 1 Needle beanng

Y ariables

Code

Wariant

Allow suppression

Defined conditions:

ok Cancel

E sufficiente fare clic con il tasto destro del mouse sul sottocomponente nell'albero principale e selezionare il
comando contestuale Aggiungi maniglia guida. A seconda delle variabili del sottocomponente, la maniglia
visualizza piu 0 meno opzioni: cambio della variante, scelta del codice di catalogo e cancellazione.
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Cosa c'e di nuovo in TopSolid'Wood

> Manage commands
Define sub-component
Update components drivers
Bill of material = SUB-ASSEMBLY

%  Geometry independent of drivers = NO

Optimize tappings
Pick trimming volume
Ignaore tools in next assembly layers = NO

Add driving handle

[ Needie bearing 10x22x13] 22 - 1] 22370[X

Guida di punti geometrici

Composant standard

[ Filtrer Standard:

AFNOR ~
Famille, lpe, variante:

[ AFNOR

- Roulement

BM Foulement & aiguilles

; Roulement & aiguilles

: Foulement & aiguiles sans be

ﬁ Ecrou
{1}1 Roulemnent & billes et rouleaus:
= Entretuize

2N

- _q Ehaudmnnene “ ]
- E Liaizon élastique :\\\\ \\\\-
]--g Fixation W
b1y Transmission
- Guidage B
£ Prafilé
‘ersion: Paramétres:
2 di=Driamétre intérieur=Smm
| v| de=Diamétre extérieur=13mm

B=Largeur=10mm

Fieprézentation:

MORMALE o
Code:
[13-m ~|
ok Annuler

| punti guida sono idonei alla creazione di maniglie, il che semplifica la modifica degli stessi quando il componente e

incluso.

8 DR
B L (0] F
P

(e ]

[]|:n2[

TopSolid

WERS SET

AR Al O P%O@;—G

[3]

Analyze

Delete

Replace

Extract

Mame

Controls

Visible = NO

Modify

Activate only layer = 0
Activate all layers
Make secondary
Manage commands

Add driving handle

More commands >
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=

RIVER HAMDLES - [4]

STEP : [Step=0)

Etape_1 (3]

F Poignée_A1 : component modification handle [Step=1]
F Poignée_AZ : component modification handle [Step=1]

ﬁ
E|

@ an"m

Blocco guida

| blocchi guida sono ora idonei alla creazione di maniglie. La maniglia di un blocco guida da accesso alle sei frecce
dello stesso.

> DRIVERS SET- ) TN
NG biock - biock i YO
S th: Pa\ellh-ckness- g Visible = VES
@ go: Groove Offset = 2 e =
@ gd: Groove depth=1 & Zoom
& assembly: Without As Deactivate level = 0

. Activate only layer = 0
o Activate all layers
& Make secondary
More commands > Manage commands
= Edit Create parameters
Edit sets Add driving handle

Raggruppamento di maniglie-parametri nell'area grafica
E possibile raggruppare e ordinare le varie maniglie-parametri create all'interno di un documento.

Trascinare e rilasciare la maniglia desiderata per agganciarla alle altre. Rilasciando la maniglia vicino a un'altra
maniglia, quest'ultima verra agganciata alla maniglia adiacente.

[ a1 [a1-250mm|

Al [a1=250mm|
A2 |A2=45"
A3 [X|

12

Una volta raggruppate le maniglie, la prima maniglia viene utilizzata per spostare il gruppo in un unico blocco.
E possibile disaggregare una o pill maniglie per generare piu gruppi di maniglie.
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Importazione semplificata delle texture

Il percorso di importazione di una cartella di texture € ora memorizzato, rendendo le future reimportazioni di texture
facili e veloci.

Library
(O User

O Group
| 2024

New texture X

Destination
|2024 v

Source
() Source file | Browse..

© Source folder | Browse...

—_—— o — —

Importazione/Esportazione di finiture e rivestimenti per progetti

E ora possibile importare o esportare le finiture e i rivestimenti di un progetto.

Import project

(C C:\TopSolid\Projets\2024\Nouveau dossier 3]\
ﬁ C:ATopSolid\Projets\2024\Nouveau dossier (3)\dd top
=] Matesials
a BRZ2024%Red Coaling
"'-' BHZ2024%Red Finishing
& HH%2024%Red Mat

Rotazione dinamica
La modalita di rotazione dinamica selezionata viene ora salvata per la sessione.
I ELTIGELGE Free rotation

Rotation type Free rotation
= Miscellaneous LEER

TopSolid 27
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Compilazione

Parte sovradimensionata

Le nuove proprieta della distinta base Overlength, Overwidth e Overthickness possono essere utilizzate per
recuperare il valore della sovradimensione in X, Y, Z. Sono disponibili nell'editor dei file di distinta base del modulo
TopSolid'Design - Proprieta fisiche.

28

Tile

COUNT
DESIGNATION
OVER_LENGTH
OVER_WIDTH
OVER_THICKNESS

CHARACTER STRING  LEFT  15mm

Definition Type
COUNT INTEGER
DESIGNATION

PART_OVER_LENGTH_VALUE REAL
PART_OVER_WIDTH_VALLE REAL

PART_OVER_THICKNESS_VALUE  REAL

Double click to enter a value

CHARACTER STRING ~ LEFT 15mm

Medification

A(PHOVER LENGTH]
Modules

Defined modules >  TopSoldDesign - Physical propesties

Function

Defined functions> OVER LENGTH

Abgn.. ‘Width Fal

g
pRE

1 Part 1825 1125 35

COUNT  DESIGNATION | STOCK_LENGTH | STOCK_WIDTH | STOCK_THICKNESS
1 Part 20 10 ['s

COUNT | DESIGNATION | OVER_LENGTH = OVER WIDTH & OVER_THICKNESS

TopSolid
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Cosa c'e di nuovo in TopSolid'Wood

La nuova proprieta Distinta ordina tipo parte dispone i tipi di parti in ordine alfabetico.

"Modiﬁcation

% 1

Title:[SORTED PART T+PE

Modules

Defined modulez > TopSolidDesign

Fumction
[Drefined functions »

SORTED PART TYPE

Parameters
Type » C
Alignment > LH

Title alignment > LE

Width 15
Format

Bar code > N
@ visible

Coluran nurnber : |4—

Usze of column

© Sort by this colur
() Make sum on thi

() Make average o

REFEREMCE|wWNER_N
ROOT OwWNER'S REFEREMCE
DESCRIFTION

SUPPLIER

PROPERTY

COMMENT

ASSEMBLY LAYER

LAYER ATTRIBUTE

INDEX

INDEX FEY

INDE 30

DIRECT O%MER'S 30 INDE>
30 INDEXIOWHER_M

ROOT OWwWNER'S 3D INDEX
INDEX KEY 3D

SECOMD INDEX 3D

DIRECT OWMER'S SECOND 3D INDEX
SECOMD 3D INDEXIOWMNER_N
ROOT OwWNER'S SECOND 3D INDEx
PROCESSING

PART TYPE

DIRECT O%/MER'S TYPE
TYPEIOWMER_M

ROOT OWMER'S TYPE

MACHIMING PROCESSES
DOCUMENT NAME

DOCUMENT NAME WITHOUT SUFFT
DOCUMENT PATH

DOCUMENT DIRECTORY

Cancel

1 Part2 A/B/C A/C/B
1 Part1 A/B/D D/B/A
NOMBRE_TOTAL | DESIGNATION | SORTED_PART_TYPE | PART_TYPE

Importante: se il nome del tipo di parte contiene <spazio>/<spazio>, verra interpretato male e diviso in due.

Codice QR nel b

locco del titolo

E possibile aggiungere un codice QR al blocco del titolo di un documento di redazione. Questo pud essere calcolato da:

= una proprieta manuale del testo o del disegno;
= una proprieta della distinta base definita nel modello multitavola.

Passare al blocco del titolo e selezionare il comando Inserisci nella cella desiderata. Fare clic sul pulsante Codice
QR, selezionare l'origine da convertire in codice QR, quindi convalidare la posizione nella cella.

Il codice QR viene inserito nella cella corrispondente del blocco del titolo.

Element in cell

X

Position in cell > ||l |
[45000mm
0K Cancel

Nota: in caso di disegni multipli, il codice QR corrisponde alla proprieta calcolata dalla distinta base.

TopSolid
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R ‘i(h-.l.';urnn 9147 | Marenst H1115-ST12 - Bamenca grige |
Length w0en| | ) LR EI
‘ wan I 1 Edges A_T_%S:th . .('-- 52
| or Designation Owner : T Woa) | 1 St =

Importante: alcuni caratteri non sono utilizzabili nella conversione dei codici QR.

Numero di supporti per pannelli

[l numero di supporti per un'entita pannello & ora disponibile nella finestra TopSolid'Wood > Numero di supporti del
pannello

Madification *

Title:|NUMEEF| OF PAMEL SUPPORTS
todules
Defined modules » TopSalid'wood A4
Function
Defined functions > MUMBER OF PAMEL SUPPORTS w
1 Multi Support | 3
1 Mono Support | 1
COUNT | DESIGNATION | NUMBER_OF_PANEL_SUPPORTS

3C TopSolid
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Dimensionamento rapido e sezione completa in modalita neutra

| comandi Quota veloce e Sezione completa sono disponibili nel punto neutro.

jian FAST DIMENSION

FULL SECTION

Rappresentazione e disegni multipli

4500

1k
Q

@ = e

Quando si creano piu disegni tramite uno script, & ora possibile selezionare il set principale.

EeF ==

-

3% ASSEMBLY : [MIXED) (6)

* D lll] @151 72 : Driver Bloc Base Box - lelh (MIXED)
# () (0) @15646 : Driver Bloc Base )

+ ) (0) @16133 : Driver Bloc B
@ (] (0) @16588 : Dri
(1 (0) @17043 : Dri
@ (] (0) @17498 : Dyi

| ———

| ——

TopSolid
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Interfaccia WoodWOP

Conversione di una perforazione oltre il diametro massimo

Durante l'esportazione di WoodWOP, se un'operazione di foratura supera il diametro massimo definito in
Strumenti > Opzioni, € ora possibile scegliere la strategia di lavorazione da adottare:

- conversione in tasca;
= conversione in percorso;
= non esportare l'operazione.

Driling opeiation

B Define masimum diameter Maximum diameter : [40.000mm Corvversion beyond the maamum diameter » | Mone v
Pocket
FRoubing aperatian

32
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Novita di TopSolid'WoodCam 6.25

Cosa c'e di nuovo in TopSolid'WoodCam

Questo capitolo descrive le novita della versione 6.25 di TopSolid'WoodCam.

Condizioni di taglio

Visualizzazione del senso di rotazione del mandrino

Nella scheda Condizioni di taglio del gestione delle operazioni, la nuova colonna Direzione mandrino visualizza il

senso di rotazione del mandrino.

General Operations list Cutting conditions

Order Machining Tool Cutting speed Spindle rate Feed rate per tooth Feed rate per minute Through fiber feed rate Spindle direction
1 Calibration [FR-2TA-16) D:16 L:B0 Cor:5 [Tool holder: TF1) B0Z2.655 mdmn 10000 rev/mn - 0.25 mm 10000 mm i
2 Groove [FR-SCIE-300-4] D:300 L:4 Cor.:4 [Tool holder: TP1) 9424 778 mdmn 10000 revimn - 0.031 mm 10000 mm - i
3 [iilling [FO-FPL-E] D:5 L:40 Cor.:8 [Tool holder : TF1) 157.08 m/mn 10000 revdmn 0.5 mm 10000 mm Mot uzed i
4 Groove [FR-2TA-10-L) D:10 L:A0 Cor:1 [Tool holder : TP1) 4159 mdmn 10000 revdmn - 0.25 mm 10000 mm CCw
Machine tool : TopSolid'woodCam 5+ R ail:Pods [MISSLER SOFTWARE - TOPSOLID"WOODCAM) Material : Hardwood
Times : Tatal=0:00:41 Feed rate =0:00:17 Fiapid = 0:00: 24
Toolpath Configuration Cancel

Operazione di posizionamento dell'etichetta per un singolo pezzo

E possibile creare un'operazione di posizionamento dell'etichetta manualmente dal menu Parte > Crea
un'operazione di posizionamento dell'etichetta se una parte & posizionata sulla macchina.

Part Weod machining  Milling 2 axis M

S ———
Positioning 3
Rails and pods 3
Flat table vacuum blocks *

I Create a labels positioning operation I

E anche possibile creare I'operazione di posizionamento dell'etichetta automaticamente quando si posiziona un
pezzo, configurando le opzioni della sezione Etichetta nelle proprieta di posizionamento del pezzo. Il modello di
distinta base viene utilizzato per definire le informazioni contenute nell'etichetta che corrispondono alle colonne

della finestra di dialogo dell'operazione.

TopSolid
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E||:| Routing configuration
[ -~ Process

Cylinders and features analysis
Part

[B] Database

----- @ Wisualization

= Hales

----- Drrillings

----- £8 Railz and pods

{_:_' R outing

----- 2 Sawing

----- &3 Mesting

----- = Part positioning

----- fi® Tools magazine

Part shifting

[ &gk shiftings values

Left/right face : [Omm

Origing
[ Origin type choice

Default ongin type > Fough faces

B Pocket frame origin o the tap of thiz one

Panel

[T Choice of elements ta take in account

Elements to take into account > All [supportz and edges and laminates)

Stock

Parel

Label

[ Create label positioning operation

Create autline

Front/back. face: ﬁ

Support(s]

Bom template:

Per impostazione predefinita, |'etichetta € posizionata al centro e sopra il riquadro che racchiude la parte. Questa
posizione puo essere modificata nelle colonne X, Y, Z della finestra di dialogo delle operazioni. Per applicare la
modifica, & necessario convalidare questa finestra di dialogo.

Il testo dell'etichetta corrisponde alla designazione del pezzo che diventa visibile all'attivazione dello strato (900).

La colonna Testo pud essere modificata anche dalla finestra di dialogo delle operazioni. Per applicare la modifica, &
necessario convalidare questa finestra di dialogo.

E possibile generare manualmente il contorno della parte nell'operazione di etichettatura o se I'opzione Crea contorno

e attivata nelle proprieta del documento.

Il
I
lld
[l

0K | Create outines YES ¥4

| parametri dell'etichetta e il percorso del contorno sono descritti nella finestra Dettagli operazione e vengono

generati in PDB come per il nesting.

Importante: per usufruire di questa nuova funzione, & necessario adattare PP nelle specifiche in base alla

macchina da azionare.
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Strumenti

Facile montaggio degli utensili di profilatura

S
Quando si crea un nuovo utensile di profilatura tramite I'icona%, ['utensile viene automaticamente selezionato

dall'elenco degli utensili per un rapido montaggio nel magazzino utensili.

Inoltre, I'elenco degli strumenti speciali € ora ordinato per data di creazione crescente anziché per diametro

crescente, per mantenere I'ultimo strumento creato alla fine dell'elenco.

TopSolid

Tool choice  Saving  Information

Tools arigin

Cosa c'e di nuovo in TopSolid'WoodCam

© Database () Prepared

Family choice
MILL TOOL ~

Types choice

SPECIAL MILL ~
Tools list
. Internal reference Tooloff.. D
— 1 | GROOWES_CLAMEX 100.
MILLS_CLAMER # 98
£ MOULDIMNG_TYFE 1 " R4
= MOULDIMG AMD COUNTER MOULDING_TYFE 2 * 140
&‘_ SIMPLE TOOL_SIMPLE CHAMFER_R 5 100
SIMFLE TOOL_SIMPLE ROUND_R 10 i 100

-
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